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เรื่องทัว่ไปเกีย่วกับ ไมโครซอฟต์โปรเจค็ 
 

       โปรแกรม Microsoft Project นี้เป็นโปรแกรมที่มีประสิทธิภาพสูงมาก สามารถจัดการ
โครงการได้ตั้งแต่ระดับธรรมดาจนถึงขั้นหลายโครงการพร้อมกัน คุณสามารถรู้ได้ทันทีว่าแผนงานต่างๆ 
นั้นจะเสร็จเมื่อใด หรือต้องการเทียบระหว่างแผนงานที่วางแผนไว้กับที่เกิดขั้นจริงว่าแตกต่างกันอย่างไร 
และสามารถที่จะดูรายงานของค่าใช้จ่ายเท่าใดที่เกิดขึ้นได้เพื่อดูว่าเกินกับงบประมาณที่วางแผนไว้
หรือไม่ อีกทั้งยังสามารถรู้ได้อย่างทันทีว่างานใดเป็นงานที่วิกฤตที่จะมีผลกระทบต่อวันเสร็จของ
โครงการ ฯลฯ 

หลายคนอาจจะเคยใช้ Microsoft Project แค่เพียงการสร้าง Gantt Chart เพื่อให้โปรแกรม
แสดงว่างานนั้นจะเสร็จแค่วันไหนเท่านั้น ซึ่งถือว่าเป็นการใช้ความสามารถของโปรแกรมแบบพื้นฐาน
เท่านั้นเอง ในการใช้โปรแกรม Microsoft Project นั้นหากคุณไม่มีความเข้าใจการท างานของโปรแกรม
อย่างถูกต้องแล้ว คุณจะรู้สึกว่าโปรแกรมนี้ใช้งานยากแต่ในความเป็นจริงแล้วใช้ไม่ยากอย่างที่คิด 
 ส าหรับการอบรมโปรแกรม Microsoft Project 2007 นี้ ผู้เข้าอบรมสามารถเข้าใจหลักการ
ท างาน การสร้างโครงการ การก าหนดทรัพยากรที่เกี่ยวข้องกับโครงการ การติดตามความก้าวหน้าของ
โครงการ และการสั่งพิมพ์แผนการด าเนินการในโครงการหนึ่งๆ ได ้
 

 ความสามารถของ Project  
      มีความสามารถในการจัดการบริหารโครงการต่างๆ ตั้งแต่การจัดการขั้นตอนล าดับการท างาน เวลา
ท างาน ทรัพยากรที่เกี่ยวข้องกับงาน รวมไปถึงการเงินต่างๆ ท าให้การจัดการบริหารโครงการขนาดเล็ก
ไปจนถึงโครงการใหญ่โดยพิจารณาในด้านต่างๆดังต่อไปนี ้

 ความสามารถในการจัดการเวลาในโครงการ  สามารถค านวณระยะเวลาที่สัมพันธ์กันทั้ง
โครงการตั้งแต่เริ่มต้นโครงการจนถึงวันสิ้นสุดโครงการ 

 ความสามารถในการจัดการทรัพยากร  อาจเป็นทรัพยากรแรงงาน (คน) หรือ สิ่งของ โดยที่เรา
สามารถทราบว่าทรัพยากรมีผลกับเวลา หรือค่าใช้จ่ายอย่างไร เพื่อเราสามารถบริหารโครงการ
อย่างมีประสิทธิภาพสูงสุด 

 สามารถจัดการค่าใช้จ่าย    การจัดท าโครงการขึ้นมานั้นย่อมต้องมีค่าใช้จ่ายมาเกี่ยวข้อง และ
ถ้าเป็นโครงการขนาดใหญ่ ย่อมต้องเกิดความซับซ้อนมาก ไมโครซอฟต์โปรเจ็ค ก็สามารถช่วย
ค านวณค่าใช้จ่ายในโครงการได้ โดยเราสามารถรู้ถึงค่าใช้จ่ายในเวลานั้น หรือ ค่าใช้จ่ายรวม ซึ่ง
ท าให้เรารู้ว่าในขั้นตอนนั้นๆ ใช้เงินไปเท่าไหร่แล้ว และควรบริหารการเงินต่อไปอย่างไร 

 การติดตาม และการตรวจสอบความก้าวหน้าของงาน  ในการบริหารโครงการนั้น ต้องมีการ
ก าหนดเวลาว่าโครงการจะเสร็จเมื่อไหร่ เราสามารถเปรียบเทียบ (Milestone) เพื่อใช้วัดความ
คืบหน้าของโครงการได ้
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 การท างานร่วมกันของโครงการ   บางครั้งเราต้องบริหารโครงการพร้อมกัน และมีการใช้
ทรัพยากรร่วมกันในโปรแกรม  ไมโครซอฟต์โปรเจ็ค ก็สามารถรองรับการท างานได ้

 การพิมพ์รายงานโครงการ  ข้อมูลต่างๆที่เราได้มานั้น เราสามารถน าเสนอให้กับสมาชิก
โครงการ หรือ ผู้ที่เกี่ยวข้องต่างๆ โดยท าออกมาในลักษณะสิ่งพิมพ์ เลือกได้ว่ารูปแบบใด 
ลักษณะใด 

 
 หลักการออกแบบโครงการ 

  โครงการที่จะประสบความส าเร็จนั้น จะเริ่มต้นตั้งแต่การออกแบบโครงการถ้าโครงการออก
แบบอย่างดี การบริหารโครงการก็ส าเร็จได้    
 

 องค์ประกอบของโครงการ 
    ก่อนการบริหารโครงการจ าเป็นต้องวางแผนสิ่งเหล่านี ้

1. งานในโครงการมีทั้งงานหนัก และงานย่อย ซึ่งเราต้องวางรายละเอียดของงาน เหล่านี้ให้
ถูกต้อง  

2. ทรัพยากร คือสิ่งที่มีผลกับการปฎิบัติงาน เช่น แรงงาน สิ่งของ 
3. ค่าใช้จ่าย คือ ค่าใช้จ่ายต่างๆในการด าเนินงาน เช่น ค่าใช้จ่ายที่มาจากการสั่งซื้อวัสดุ หรือ 

ค่าใช้จ่ายที่เป็นส่วนค่าจ้างพนักงาน 
4. เวลา คือระยะเวลาในส่วนต่างๆของโครงการ ซึ่งแต่ละขั้นตอนอาจมีระยะเวลาในการท างาน

ไม่เท่ากัน  
 

 ขั้นตอนการออกแบบโครงการ 
  ในการเริ่มต้นบริหารจัดการโครงการ เราต้องมีการวางแผนโครงการมาอย่างดี ซึ่งเป็นขั้นตอนที่
ใช้เวลาและความคิดไม่น้อย เราต้องลงรายละเอียดให้รอบคอบก่อนน าไปใช้ในโปรแกรม  ไมโครซอฟต์
โปรเจค็ แบ่งการออกแบบและขั้นตอนจากเริ่มต้นจนถึงขั้นบริหารได้ 7 ขั้นตอน 

1. ก าหนดวัตถุประสงค์และเป้าหมายโครงการ 
2. หาผู้สนับสนุนโครงการ และมีสัญญาที่ชัดเจน 
3. ศึกษาขั้นตอนและท าเป็นเอกสาร 
4. เขียนแผนงานที่ปฏิบัติได้จริง 
5. ก าหนดทีมงาน 
6. ประเมินปัจจัยเสี่ยง 
7. ลงมือปฎิบัติ 



 เอกสารประกอบการอบรม  Microsoft Project 2007                                           หน้าที่ 3 
 

 
Training Service (ICT Center) 
 

 ส่วนประกอบส าคัญในการจัดการโครงการ  
ในการบริหารโครงการด้วย Project 2007 มีส่วนต่างๆที่ต้องพิจารณาดังนี ้
  งาน (Task) 
    ในโปรแกรม  Project 2007 ให้เราระบุงานและก าหนดรายละเอียดของงานที่ท าในโครงการ 
นอกจากนั้นยังจัดล าดับของงาน ก าหนดระยะเวลาของแต่ละงาน รวมทั้งการจัดสรรทรัพยากรและ
ค่าใช้จ่ายให้กับงานได ้
  ทรัพยากร (Resource)  

   เราสามารถก าหนดทรัพยากรที่เราต้องการได้โดย Project 2007 จะเก็บข้อมูลของทรัพยากร
แยกออกจากงาน และสามารถเชื่อมโยงเพื่อท างานร่วมกันได้  
 ค่าใช้จ่าย (Cost) 

ในโปรแกรม Project 2007 สามารถจัดการค่าใช้จ่ายโดยให้เราก าหนดรายละเอียดต่างๆและ
ช่วยค านวณค่าใช้จ่ายแต่ละส่วนได้ 
 เวลา (Time) 
     เนื่องจากงานต่างๆ ในโครงการนั้น มีความสัมพันธ์กัน ดังนั้นการควบคุมเวลาในแต่ละงานจึง
เป็นเรื่องส าคัญ เพื่อให้โครงการเสร็จในเวลาที่ก าหนด ซึ่งโปรแกรม Project 2007 สามารถช่วยค านวณ
เวลา และให้ความสะดวกในการจัดการเกี่ยวกับเวลาในรางการได้เป็นอย่างดี 
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 ส่วนประกอบของเครื่องมือใน  Project 2007 

Standard Toolbar 

 

 
ส าหรับสั่งเปิดไฟล์ใหม ่

  
ส าหรับสั่งเปิดไฟล์ที่เคยบันทึกไว้ 

 
ส าหรับสั่งบันทึกไฟล์ 

 
ส าหรับสั่งค้นหาไฟล์ 

 
ส าหรับพิมพ์งานออกทางเครื่องพิมพ์ 

 
ส าหรบัสั่งขอดูงานก่อนพิมพ ์

 
ส าหรับตัดข้อมูล 

 
ส าหรับสั่งท าส าเนาเฉพาะรูปภาพ 

 
ส าหรับวางส าเนาข้อมูล 

 
ส าหรับสั่งท าส าเนาเฉพาะรูปแบบ 

 
ส าหรับสั่งยกเลิกค าสั่งล่าสุด 

 
ส าหรับสั่งให้ท าซ้ าค าสั่งที่ได้ยกเลิกไปด้วยค าสั่ง Undo 

 
ส าหรับสร้างความสัมพันธ์แบบ Finish to Start 

 
ส าหรับยกเลิกความสัมพันธ์ 

 
ส าหรับแบ่งงานออกเป็นส่วนๆ 

 
ส าหรับเปิดไดอะล็อกบ๊อกซ์ รายละเอียดของงาน 

 
ส าหรับเปิดไดอะล็อกบ๊อกซ์ รายละเอียดของงานเพื่อเขียนบันทึก 

 
ส าหรับเปิดไดอะล็อกบ๊อกซ์ Assign Resource 

 ส าหรับจัดกลุ่มข้อมูล 

 
ส าหรับเปลี่ยนหน่วยของเวลาในมุมมองละเอียดยิ่งขึ้น 

 
ส าหรับเปลี่ยนหน่วยของเวลาในมุมมองหยาบยิ่งขึ้น 

 ส าหรับเปลี่ยนช่วงเวลาใน Gantt Chart ด้านขวาให้พอดีกับงานที่
เลือกไว้ 
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Formatting Toolbar 

 

 
ส าหรับยกเลิกการย่อชื่องาน 

 ส าหรับย่อชื่องาน 

 ส าหรับแสดงงานย่อย 

 
ส าหรับซ่อนงานย่อย 

 
ส าหรับซ่อนรายชื่อของ Assignment 

 
ส าหรับให้แสดงข้อมูลกี่ระดับแรก 

 
ส าหรับเลือกชื่อฟอนต์อักษร 

 ส าหรับก าหนดขนาดฟอนต์อักษร 

 
ส าหรับท าตัวอักษรเป็นตัวเข้มหรือตัวหนา 

 
ส าหรับท าอักษรเป็นตัวเอน 

 
ส าหรับท าตัวอักษรให้มีขีดเส้นใต้ 

 
ส าหรับก าหนดข้อมูลให้ชิดซ้ายของเซลล์ 

 ส าหรับก าหนดข้อมูลให้อยู่ตรงกลางเซลล์ 

 
ส าหรับก าหนดข้อมูลให้ชิดขวาของเซลล์ 

 ส าหรับเลือกชื่อฟิลเตอร์เพื่อคัดกลองข้อมูล 

 
ส าหรับเรียกการคัดกรองข้อมูลอัตโนมัติ 

 
ส าหรับเยกค าสั่ง Gantt Chart Wizard 

 

Tracking Toolbar 

 

 
ส าหรับแสดงค่าข้อมูลสถิติทั่วไปของโครงการ 

 
ส าหรับอัปเดตงานตามแผน 

 ส าหรับสั่งให้วางแผนใหม่ 

 ส าหรับใส่เส้นบอกความก้าวหน้าของงาน 

 ส าหรับอัพเดตความก้าวหน้าของงานเป็น0% 

 ส าหรับอัพเดตความก้าวหน้าของงานเป็น25% 
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 ส าหรับอัพเดตความก้าวหน้าของงานเป็น50% 

 
ส าหรับอัพเดตความก้าวหน้าของงานเป็น75% 

 ส าหรับอัพเดตความก้าวหน้าของงานเป็น100% 

 ส าหรับแสดงไดอะลอกบ๊อกซ์การอัพเดตข้อมูลของ
งาน 

 

PERT Analysis Toolbar 

 

 ส าหรับแสดง Gantt Chart ของระยะเวลาที่เร็วที่สุด 

 ส าหรับแสดง Gantt Chart ของระยะเวลาปานกลาง 

 
ส าหรับแสดง Gantt Chart ของระยะเวลาที่ช้าที่สุด 

 ส าหรับค าสั่งให้มีการค านวนระยะเวลาที่เหมาะสม 

 
ส าหรับแสดงฟอร์มเพื่อป้อนข้อมูล 

 
ส าหรับเปลี่ยนน้ าหนักการค านวณ 

 
ส าหรับแสดงมุมมอง PA_PERT Entry Sheet 

 
 

 เริ่มต้นโปรแกรมด้วยการเลือก ค าสั่ง File->New  
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 รูปแบบการสร้างโครงการใหม่ 
สามารถก าหนดได้ 2 รูปแบบ คือ 

1.  การก าหนดโดยดูจากวันท่ีเร่ิมตน้โครงการ (Project Start Date) 
2.  การก าหนดโดยดูจากวันท่ีสิน้สุดโครงการ (Project Finish Date) 

 
ในการสร้างโปรเจ็คนั้น เราจะต้องท าการเลือกปฏิทินให้เหมาะสมกับโปรเจ็คของเราโดยเลือก 

Project > Project Information จากนั้นจะได้ตารางที่บอกรายละเอียดเกี่ยวกับวันและเวลา จากนั้นจึงท า
การเลือกลักษณะปฏิทินให้เหมาะสมกับโปรเจคของเรา 

 
 

 การเลือกปฏิทิน (Calendar) การท างานของโครงการ 
     ต้องมีการก าหนดว่าโครงการของเรามีปฏิทินการท างานแบบไหน โดยก าหนดชั่วโมงในการ
ท างานของแต่ละวัน ซึ่งมีให้เลือก 3 แบบ 

1. แบบมาตรฐาน (standard) โดยเริ่มต้นแล้วโปรแกรมจะตั้งค่าให้ ซึ่งหมายถึงการท างาน
ตามมาตรฐานสากล คือ ท างานตั้งแต่วันจันทร์ ถึงวันศุกร์ เวลา 08.00-12.00 และ 
13.00-17.00 

2. แบบ 24 ชั่วโมง คือ การก าหนดให้ท างานวันละ 24 ช.ม. ทุกวันจันทร์ ถึง วันอาทิตย์  
โดยไม่มีการหยุดพัก 

3. แบบการท างานกลางคืน คือการท างานเป็นกะเวลาโดยอยู่บนพื้นฐานของการท างาน
แบบ 40 ช.ม. /อาทิตย์ 
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 รู้จักมุมมองของใน Project 2007 
 

มุมมอง (View) 
   ช่วยให้ผู้บริหารสามารถมองเห็นโครงการจากด้านหรือมุมมองต่างๆ ที่หลากหลาย  
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ตารางต่อไปนี้อธิบายถึงมมุมองต่างๆตามลักษณะที่ปรากฏ 
 

ประเภทมุมมอง ค าอธิบาย 
มุมมองประเภท Gantt 
Chart          
 

มุมมองทางด้านซ้ายจะเป็นตารางงส าหรับป้อนข้อมูล ส่วนทางด้านขวา
จะเป็น Gantt Chart  

 
มุ ม ม อ ง ป ร ะ เ ภ ท 
Calendar 
 

มุมมองที่แสดงในรูปปฏิทิน และแสดงงานที่ต้องท าในแต่ละวันในรูป
ของแท่งกราฟบนปฏิทิน 

 
มุ ม ม อ ง ป ร ะ เ ภ ท 
Diagram  

มุมมองที่แสดงงานต่างๆในรูปของกรอบสี่เหลี่ยมและมีเส้นโยงให้เห็น
ความสัมพันธ์ของงาน ต่างๆ มุมมอง 
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มุ ม ม อ ง ป ร ะ เ ภ ท 
Usage 

มุมมองที่ด้านซ้ายแสดงรายการชื่องาน หรือ ทรัพยากร พร้อมทั้ง 
Assignment ส่วนทางขวาเป็นตารางแสดงข้อมูลเกี่ยวกับงาน หรือ 
ค่าใช้จ่าย 
 

 
 

มุ ม ม อ ง ป ร ะ เ ภ ท 
Sheet 

มุมมองที่มีแต่ตารางส าหรับป้อนข้อมูล 

 
 

มุมมองประเภท Form  มุมมองที่มีลักษณะเป็นแบบฟอร์มส าหรับป้อนข้อมูล 
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มุ ม ม อ ง ป ร ะ เ ภ ท 
Graph  

มุมมองที่เป็นกราฟ มุมมองประเภทนี้ได้แก่ Resource Graph 

 
 

 
นอกจากนีเ้ราสามารถพิจารณามุมมองต่างๆ จากคุณสมบัติต่อไปนี ้
 Task แสดงข้อมูลของงานส าคัญ ส่วนใหญ่มักได้แก่ มุมมองที่มีค าว่า Task ประกอบในชื่อของ

มุมมอง เช่น     Task Details Form เป็นต้น มุมมองเหล่านี้จึงเหมาะกับการป้อนหรือแก้ไข
ข้อมูลเกี่ยวกับงาน 

 Resource แสดงข้อมูลของทรัพยากรเป็นส าคัญ ส่วนใหญ่มักได้แก่ มุมมองที่มีค าว่า Resource 
ประกอบในชื่อของมุมมอง เช่น Resource Form เป็นต้น มุมมองเหล่านี้เหมาะกับการป้อนหรือ 
แก้ไขข้อมูลเกี่ยวกับทรัพยากร 

 Usage แสดงข้อมูลของ Assignment เป็นส าคัญ มีให้ใช้อยู่สองแบบนั่นคือ Task  Usage และ 
Resource Usage เหมาะส าหรับการป้อน หรือแก้ไขข้อมูลเกี่ยวกับ Assignment 

 
 ฟิลด์ข้อมูล 
ใน Microsoft Project ได้จัดเตรียมฟิลด์ส าหรับเก็บข้อมูลประเภทต่างๆ ที่เป็นรายละเอียดของ
งาน และของโครงการไว้ให้แล้ว ฟิลด์ในไมโครซอร์ฟโปรเจ็ค มี 3 ประเภท คือ 
1. Calculated คือฟิลด์ที่ค านวณข้อมูลในฟิลด์นี้เองโดยอัตโนมัติ ผู้ใช้ไม่ต้องป้อนข้อมูล เช่น  
ฟิลด์ Critical  ซึ่งเก็บข้อมูลว่างานเป็นงานวิกฤตหรือไม่ ถ้างานเป็นงานวิกฤต เก็บค าว่า Yes 
ถ้างานไม่เป็น เก็บค าว่า No ฟิลด์นี้เราไม่สามารถป้อนข้อมูลลงไปเองได้  

2. Entry หมายถึง ฟิลด์ที่ผู้ใช้ต้องป้อนข้อมูลลงไปเองเท่านั้น  ไมโครซอร์ฟโปรเจ็คต์จะไม่ป้อน
ให้ เช่นฟิลด์ Predecessor ที่ผู้ใช้ต้องป้อนหมายเลขของงานที่เป็น Predecessor ลงไปเอง 
ไมโครซอร์ฟโปรเจ็คต์ ไม่สามารถป้อนให้ได ้

3. Calculate &  Entry หมายถึง ฟิลด์ที่ไมโครซอร์ฟโปรเจ็คต์ จะค านวณข้อมูลให้ก่อน แต่หาก
ผู้ใช้เห็นว่าไม่เหมาะสม ก็ยังสามารถป้อนข้อมูลใหม่ลงไปได้เอง เช่น ฟิลด์ Start หรือ  ฟิลด์ 
Finish จะเห็นว่า ทันทีที่เราป้อนชื่องานลงในไมโครซอร์ฟโปรเจ็คต์ เราจะได้ข้อมูลที่เป็นวัน
เริ่มงานและเสร็จงานมาเองโดยอัตโนมัติ หากต้องการป้อนข้อมูลวันเริ่มและวันเสร็จงานด้วย
ตนเอง ก็ยังสามารถท าได้ทันท ี
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 การแสดงฟิลด์เพิ่มในตารางและการซ่อนฟิลด์ที่ไม่ต้องการ 
 ตามปกติ ฟิลด์ข้อมูลที่ไมโครซอร์ฟโปรเจ็คจัดเตรียมไว้ มีมากว่าที่เรามองเห็น วิธีการแสดง
ฟิลด์เพิ่มในตารางใดๆท าได้ดังต่อไปนี้ 

1. ท างานอยู่บนตารางที่ต้องการจะแสดงฟิลด์เพิ่ม 
2. เลือกคอลัมน์ซึ่งอยูบ่นต าแหน่งที่ต้องการจะแสดงฟิลด์เพิ่ม 
3. คลิกขวาเลือกค าสั่ง Insert Column 
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การป้อนข้อมูลเกี่ยวกับโครงการ 
 

ก่อนที่จะเริ่มต้นให้ ไมโครซอฟต์โปรเจ็ควางแผนโครงการให้ เราต้องจัดเตรียมความพร้อมของ
โปรแกรมให้สอดคล้องกับความเป็นจริงเสียก่อน เพื่อไม่ให้การวางแผนของไมโครซอฟต์โปรเจ็ค ดังนั้น 
เนื้อหาของบทนี้จะอธิบายถึง การก าหนดรายละเอียดของโครงการ (Project Information) และการ
ก าหนดปฏิทินการท างาน (Change working time) ซึ่งรวมถึงเรื่องของการก าหนดจ านวนชั่วโมงให้กับ
หน่วยของเวลาที่เป็นวัน (day) และสัปดาห์ (week) 
    งานคือกิจกรรมที่จะต้องถูกกระท า เพื่อให้โครงการบรรลุประสงค์ ส าหรับเนื้อหาจะแนะน าการ
ป้อนข้อมูลเกี่ยวกับงาน เป็นประเภทๆไป ตามคอลัมน์ที่ปรากฎอยู่ในตาราง Entry ของมุมมอง Gantt 
Chart ดังต่อไปนี ้
 

 การป้อนชื่องาน (Task Name) 
สามารถแบ่งเป็นประเภทต่างๆ อันได้แก่ 
 ข้อมูลเกี่ยวกับงานที่เราสามารถป้อนลงในไมโครซอฟต์โปรเจ็ค ก็คือ ชื่อของงานโดยป้อนลงไป
ในคอลัมน์ Task Name ในตาราง Entry ของมุมมอง Gantt Chart 

1. Task งานในระดับปกติ (Normal) 
2. Summary Task งานใหญ่ที่ประกอบไปด้วยงานย่อยๆ ความส าเร็จของงานประเภทนี้ได้มาจาก

ความส าเร็จของงานย่อยๆที่ประกอบกันขึ้นมา 
3. Sub Task  งานย่อยvหรืองานซึ่งเป็นองค์ประกอบของงานใหญ่ ความส าเร็จของงานเหล่านี้ คือ

ความส าเร็จของงานใหญ ่
4. Milestone งานที่ใช้เป็นจุดสังเกตบอกความก้าวหน้าของโครงการ 
    

 การป้อนข้อมูลเกี่ยวกับโครงการ 
       การวางแผนโครงการจะวางแผนจากวันที่เริ่มโครงการไปหาวันที่เสร็จโครงการ หรือ จะให้
วางแผนจากวันสิ้นสุดโครงการย้อนกลับมาหาวันที่เริ่มต้นโครงการ นอกจากนั้น ยังบอกได้ว่า ท างานวัน
ไหน และไม่ท างานวันไหน ไมโครซอฟต์โปรเจ็ค  จะวางแผนให้ กล่าวคือ จะท าการก าหนดเวลา ที่งาน
แต่ละงานจะต้องท า ดังนั้น ไมโครซอฟต์โปรเจ็ค จึงต้องทราบข้อมูลต่างๆเหล่านี้ เพื่อจะได้วางแผนได้
อย่างถูกต้อง  

1. คลิกที่ค าสั่ง ProjectProject Information 
2. ในไดอะล็อกบ๊อก ของ Project Information ให้ป้อนข้อมูลต่างๆ  
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 จากนั้นท าการกรอกรายละเอียดขั้นตอนต่างๆ ของโปรเจ็คในช่อง Task name พร้อมกรอก
เวลาที่ ช่อง Duration 

 

 
 
 
 
 
 



 เอกสารประกอบการอบรม  Microsoft Project 2007                                           หน้าที่ 16 
 

 
Training Service (ICT Center) 
 

 ข้อมูลเกี่ยวกับการวางแผน     
 ให้เลือกที่ Schedule from โดยหากต้องการให้ไมโครซอฟต์โปรเจ็ค วางแผนงานจากวันเริ่มต้น
โครงการเป็นต้นไป ให้เลือกเป็น Project Start Date แต่หากต้องการให้ ไมโครซอฟต์โปรเจ็ค วางแผน
จากวันสิ้นสุดโครงการย้อนกลับเข้ามา ให้เลือกเป็น Project Finish Date  
 การก าหนดวิธีการวางแผนงานเป็น Project Finish Date ใช้ในการวางแผนที่ไม่ทราบวันเริ่ม
โครงการที่แน่นอน แต่ทราบวันที่สิ้นสุดโครงการ ซึ่งการก าหนดการวางแผนด้วยวิธีนี้จะช่วยให้ทราบได้
ว่าโครงการควรจะเริ่มต้นอย่างช้าที่สุดในวันใด 
 

 การเชื่อมต่องาน (Link) 
           ในโครงการส่วนใหญ่นั้นงานบางงานสามารถเสร็จได้ด้วยตัวของมันเองแต่ก็มีงานอีกมากมายที่
จ าเป็นต้องอาศัยการเกิดตามล าดับขั้นตอนหรือตามล าดับเวลา นั่นคืองานหนึ่งๆ ไม่สามารถเกิดได้เมื่อ
งานก่อนหน้านี้ยังไม่สิ้นสุด เช่น ในการท างานโดยทั่วไปนั้นจ าเป็นต้องอาศัยการวางแผนงานก่อน 
ล่วงหน้าจึงจะสามารถท างานในขั้นตอนต่างๆ ที่ถัดมาได้ เป็นต้น โดยท าการเชื่อมขั้นตอนต่างๆ ให้ต่อ
กัน โดยครอบขั้นตอนทั้งหมดแล้วกดที่ Link Tasks แล้ว โปรแกรมจะท าการรวมขั้นตอนต่างๆ แล้วจะ
แสดงผลทางด้านขวา 
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การเชื่อมต่องานนั้น เป็นการก าหนดให้งานมีความสัมพันธ์ กันคือ เมื่อสิ้นสุดงานแรกแล้ว จึง

สามารถท างานถัดมาได้ เหมาะส าหรับงานที่ต้องการท าต่อเนื่องกันไป โดย ที่ลักษณะของที่เชื่อมต่องาน
นั้นสามารถแบ่งการท างานออกเป็นประเภทต่างๆ ดังนี้ 
 
ประเภทความสัมพันธ์ของงาน  มี 4 ชนิดด้วยกัน คือ  

1. งานที่มีการเชื่อมต่อจากจุดสิ้นสุดไปที่จุดเริ่มต้น (Finish-to-Start) หรือ FS  การ
เชื่อมต่อแบบนี้ เป็นความสัมพันธ์ที่เมื่องานแรกสิ้นสุดลง งานถัดมาจึงจะสามารถท าได้ 
ซึ่งการเชื่อมต่อแบบนี้เป็นวิธีการที่ค่อนข้างใช้บ่อย อีกทั้งยังเป็นการเชื่อมต่อแบบ

มาตรฐาน (Default) ของ Project 2007 อีกด้วย       
2. งานที่มีการเชื่อมต่อจากจุดสิ้นสุดไปยังจุดสิ้นสุด (Finish-to-Finish) หรือ FF 

การเชื่อมต่องานแบบนี้โดยทั่วไปจะหมายถึงงานที่แตกต่างกัน 2 งาน แต่จะเสร็จใน
เวลาเดียวกัน เช่น เราก าลังออกแบบวารสารกี่ยวกับคอมพิวเตอร์ เมื่อ Layout ของ
งาน (Predecessor) มีการออกแบบเสร็จแล้ว นั่นหมายถึงการสิ้นสุดการขายโฆษณา 
(Successor) เนื่องจากในขณะนั้นรูปแบบของวารสารได้มีการออกแบบไว้เสร็จแล้ว 

ดังนั้นจึงไม่มีการเพิ่มเติมส่วนที่เป็นโฆษณาอีกแต่อย่างใด  
3. งานที่มีการเชื่อมต่อจากจุดเริ่มต้นไปยังจุดเริ่มต้น (Start-to-Start) หรือ SS การ

เชื่อมต่อแบบนี้จะเป็นการเชื่อมต่องาน 2 งานที่มีวันเริ่มเป็นวันเดียวกัน โดย จะมีการ
เรียกใช้การเชื่อมต่อแบบนี้เมื่อเราเห็นว่า ทรัพยากรที่ท างานทั้ง 2 นี้มีความสัมพันธ์กัน

สามารถท างานควบคู่กันไปได้  
4. งานที่มีการเชื่อมต่อจากจุดเริ่มต้นไปยังจุดสิ้นสุด (Start-to-Finish) หรือ SF การ

เชื่อมต่องานแบบนี้จะมีความซับซ้อนมากกว่าในแบบอื่นๆ ซึ่งจะเป็นวิธีที่มีการใช้น้อย
ที่สุดอีกด้วย โดยที่วิธีนี้งานที่เป็น Predecessor จะไม่สามารถเสร็จได้จนกระทั่งงานที่

เป็น Successor เริ่มต้น   

ลูกศรแสดงงานที่
เชื่อมต่อกัน 
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 การสร้างความสัมพันธ์ด้วยการ Link Task   
1. เลือกงานคู่ที่ต้องการสร้างความสัมพันธ์  

2. คลิกที่ปุ่ม    Link Task  บนสแตนดาร์ดทูลบาร์ Project 2007 จะสร้าง
ความสัมพันธ์แบบ FS ให้ โดยสามารถแก้ไขความสัมพันธ์ได้ด้วยการดับเบิ้ลคลิกที่เส้น
แสดงความสัมพันธ์ใน Gantt Chart ดังกล่าว  Project 2007 จะแสดงไดอะลอกบ็อก
ของ Task Dependency ให้แก้ไขรายละเอียดของความสัมพันธ์ดังรูป 

 
 

 การใช้งาน Lead และ Lag Time 
การใช้งาน Lead และ Lag Time ส าหรับงานใดๆ นั้น เป็นการก าหนดระยะเวลาของ  

Predecessors โดยจะเริ่มต้นช้า หรือเร็วขึ้นอยู่กับประเภทของความสัมพันธ์ที่ได้ก าหนดไว้ว่าเป็นแบบ
ใด 
 ลักษณะและรูปแบบของการก าหนด Lead และ Lag Time 

1. Lead Time : เป็นรูปแบบของงานตาม (Successor) ที่จะมีการเหลื่อมกับงานที่เป็นงาน
แรก (Predecessor) นั่นคืองานที่เป็นงานตาม จะสามารถเริ่มต้นท าได้โดยที่งานที่เป็นงานแรกยังไม่
เสร็จสิ้น ส าหรับในงานที่มีการเชื่อมต่อแบบ Finish-to-Start ดังรูป 

  
 
2. Lag Time : เป็นรูปแบบของงานที่มีความล่าช้า (Delay) นั่นคืองานตาม (Successor) 

จะเริ่มต้นได้ก็ต่อเมื่องานแรกได้สิ้นสุดลง และมีการยืดระยะเวลาออกไปตามที่ก าหนดไว้ ดังรูป 

 
 
การก าหนด Lead และ Lag Time  
ในการก าหนด Lead และ Lag Time นั้น เราจ าเป็นจะต้องทราบเกี่ยวกับรายละเอียดของ Task 

Dependency ซึ่งไดอะล็อกซ์ของ Task Dependency มักใช้งานในการลบ หรือการเปลี่ยนชนิดของการ
เชื่อมต่องาน รวมถึงการก าหนด Lead และ Lag Time อธิบายได้ดังนี ้
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From :  เป็นงานเริ่มต้นที่มีการเชื่อมต่อหรือ Predecessor 
To :  เป็นงานสิ้นสุดที่มีการเชื่อมต่อหรือ Successor 
Type:   แสดงชนิดของการเชื่อมต่อ โดยที่เราสามารถเปลี่ยนชนิดการเชื่อมต่อได้โดย 

การคลิกเม้าส์บนปุ่ม  
 Lag:  เป็นการก าหนด Lead และ Lag Time ได้ที่นี ่
 Delete:  เป็นปุ่มที่ใช้ในการลบการเชื่อมต่องาน 
 และในส่วนของ Lead และ Lag Time นั้น จะใช้ไดอะล็อกซ์ Task Dependency ดังกล่าวในการ
ก าหนด ซึ่งเราสามารถท าได้ด้วยวิธีการ ดังต่อไปนี้ 

1. ดับเบิ้ลคลิกบนแนวการเชื่อมต่อระหว่างงานทั้งสองที่ต้องการท า Lag หรือ Lead Time 
จากนั้นจะปรากฎ Task Dependency ขึ้น 

2. คลิกปุ่ม  ขึ้นหรือลง ในส่วนของ Lag เพื่อก าหนดจ านวนวันที่ใช้ในการ Lag หรือ Lead 
โดยที่  

 ก าหนดค่าเป็นลบ จะเป็นการก าหนด Lead Time 
 ก าหนดค่าเป็นบวก จะเป็นการก าหนด Lag Time 

3. คลิกปุ่ม ในส่วนของ Type เพื่อเลือกชนิดที่ต้องการเชื่อมต่อ ในที่นี้เลือก Finish-to-Start 
ส าหรับการ Lead Time และ Lag Time 

4. คลิกเมาส์ปุ่ม OK เป็นการก าหนด Lead และ Lag Time  
 

  
 
 

แสดง Lead – Time 
ส าหรับงานทีม่ีการเชื่อมต่อ
แบบ Finish-to-Start 
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 การยกเลิกความสัมพันธ์  
การยกเลิกความสัมพันธ์สามารถท าได้หลายวิธี  ดังต่อไปนี ้

1. เลือกงานทั้งหมดที่ต้องการจะยกเลิกความสัมพันธ์ คลิกที่ปุ่ม   Unlink Task หรือ 
2. ดับเบิ้ลคลิกที่เส้นความสัมพันธ์คู่ที่ต้องการลบ คลิกปุ่ม Delete ในไดอะลอกบ็อกซ์ของ 

Task Dependency 
 

 งานหลัก (Summary Task) และ งานย่อย (Subtask) 
    ในการวางแผนโครงการของเรานั้น เราต้องระบุว่าแผนของเรานั้นมีงานอะไรบ้าง และใครเป็นผู้
ดูรับผิดชอบงานแต่ละชิ้น ถ้าเราแจงงานหลัก (Summary Task) ออกมาเป็นงานย่อย (Subtask) เพราะ
จะช่วยให้เราติดตามงานได้ง่ายขึ้น  
 

  

แสดง Lag – Time ส าหรับ
งานที่มีการเชื่อมต่อแบบ 
Finish-to-Start 
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หากต้องการท าให้งานมีงานย่อยสามารถท าได้ดังนี ้
1. เลือกชื่องานที่เป็นงานย่อยของงานใหญ่ๆ 

2. คลิกปุ่ม  เพื่อขยับชื่องานให้เยื้องเข้าไปข้างใน 
3. งานที่อยู่เหนือกว่าด้านบนจะกลายเป็นงานใหญ่ทันที 

4. การยกเลิก คลิกปุ่ม    
 

 การติดตามความคืบหน้าของงาน โดยใช้ Task  
การก าหนดความคืบหน้าของงานโดยใช้ Task นั้น เป็นการเปลี่ยนแปลงโดยผู้ใช้งาน ซึ่ง

ตามปกติแล้ว ผู้ด าเนินโครงการจะทราบถึงความคืบหน้าของงานที่เกิดขึ้น และต้องการที่จะท าการ
เปลี่ยนแปลงข้อมูลความคืบหน้าของงานให้ตรงกับความเป็นจริง 

 
ก าหนดความคืบหน้าของงานด้วยการใช้ Tracking Toolbar 
ใน Project 2007 มีเครื่องมือ Tracking Toolbar ไว้ใช้ในการบันทึกความคืบหน้าของโครงการ

ในขณะด าเนินงานได้ โดยเมื่อเลือกค าสั่ง View > Toolbars > Tracking จะปรากฎ Tracking Toolbar ที่
ด้านบนของจอภาพ ดังรูป  

 

 
 
 การก าหนดความคืบหน้าของงาน โดยใช้ Tracking Toolbar เป็นการก าหนดตามอัตรา
เปอร์เซ็นต์ที่มีอยู่แล้ว โดยมีค่าเปอร์เซ็นต์ของงานที่ส าเร็จ ดังนี้ คือ 0%, 25%, 50%, 75% และ 100%  
 ส าหรับการก าหนดความคืบหน้าของงานโดยใช้ Task มีดังนี ้

1. คลิกเมาส์เลือกงานที่ต้องการ 
2. คลิกเมาส์เลือกเปอร์เซ็นต์ของงานที่ส าเร็จภายใน Tracking Toolbar 

 
 
ก าหนดความคืบหน้าด้วยการใช้เมาส์ 
วิธีนี้ เป็นวิธีที่ค่อนข้างสะดวก รวดเร็ว โดยการใช้เมาส์ก าหนดความคืบหน้าของงานได้เลย 
1. วางเมาส์ชี้ที่ด้านซ้ายของแถบ Task ที่ต้องการ Update ใน Gantt Chart ตัวชี้เมาส์จะแสดง

เป็นเปอร์เซ็นต์ (%) 
2. คลิกเมาส์ค้างไว้ และลากไปทางด้านขวา จะปรากฎแผนภาพ Progress แสดงความคืบหน้า

ของงาน ซึ่งขณะที่ท าการลากนั้น เปอร์เซ็นต์ของความคืบหน้าของงานจะมีการเปลี่ยนแปลงไปตามระยะ
ที่ได้ลากไป โดยจะแสดงเป็นเส้นด าใน Task 
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การก าหนดรายละเอียดความคืบหน้า 
วิธีนี้ จะใช้เวลานานกว่าการใช้เมาส์ แต่จะสามารถก าหนดรายละเอียดเพิ่มเติมเกี่ยวกับความ

คืบหน้า ของงานได ้
1. คลิกเมาส์เลือกงานที่ต้องการก าหนดความคืบหน้า 

 
 
2. เลือกค าสั่ง Tools > Tracking > Update Tasks > จะปรากฎหน้าส าหรับก าหนดความ

คืบหน้า 

 
 
3. เราสามารถระบุความคืบหน้าของงานได้ 2 วิธี ดังนี ้
 3.1 ใส่เปอร์เซ็นต์ของความส าเร็จของงานในช่อง % Complete 
 3.2 ใส่จ านวนวันท างานที่ท าไปแล้วในช่อง Actual dur 
 และยังสามารถก าหนดรายละเอียดเพิ่มเติม ได้ดังนี้ 
 ใส่จ านวนวันที่เหลืออยู่ของงาน 
 หัวข้อ Actual ใส่วันเริ่มต้น และจบ ของงานที่เป็นจริง 
 หัวข้อ Current ใส่วันเริ่มต้น และจบ ของงานที่เราวางแผนไว้ 
 ใส่ Notes เพื่ออธิบายเพิ่มเติมว่า ท าไมงานจึงเสร็จก่อน หรือล่าช้ากว่าก าหนด โดยให้

คลิกเมาส์ที่ปุ่ม Notes… 
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 การก าหนดค่าความคืบหน้าของงานทั้งโครงการ 
ในการก าหนดค่าความคืบหน้าของงานนั้น เราสามารถก าหนดได้ทั้งโครงการ โดยระบุวันที่ว่า

งานของเราคืบหน้าไปถึง จากนั้น Project 2007 จะท าการก าหนดทุกงานให้คืบหน้าไปถึงวันที่เรา
ก าหนด 

1. ในกรณีที่ต้องการ Update งานให้คลิกเม้าส์เลือกงานในตาราง 
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2. เลือกค าสั่ง Tools > Tracking > Update Project จะปรากฎหน้าต่าง Update Project 

 
 
3. ก าหนดหัวข้อในการ Update ข้อมูลต่าง ๆ ดังนี ้
 Update word as complete through: ใช้ก าหนดวันที่งานคืบหน้าไปถึง 
 เลือกเปอร์เซ็นต์ของงานที่เสร็จ โดยที ่

 Set 0% - 100% Complete จะเป็นการแสดงงานที่เสร็จจริงในช่วง 0% - 100% 
 Set 0% or 100% Only จะเป็นการแสดงงานที่เสร็จจริงเพียง 2 ค่า คือ 0% กับ 

100% นั่นคือ ถ้าในวันที่เราก าหนดในหัวข้อ Update work as complete 
through งานนั้นยังไม่เสร็จจะแสดงค่างานเป็น 0% แต่ถ้างานเสร็จจะแสดงค่า
งานเป็น 100% 

 หัวข้อ Entire project เมื่อต้องการ Update งานทั้งหมด 
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 หัวข้อ Selected tasks เพื่อ Update เฉพาะงานที่ได้มีการเลือกไว้แล้ว 
4. คลิกเม้าส์ปุ่ม OK เป็นการสิ้นสุดการ Update งานของโครงการ 
 

 
 
 การจัดสรรทรัพยากรต่างๆ ที่เกี่ยวข้องกับงานในโครงการ 

 

จะต้องเลือกที่ Resource Sheet ตรง View bar ด้านข้างดังรูป 
 

 
 

จากนั้นท าการป้อนข้อมูลลงไป ซึ่งมีรายละเอียดที่ส าคัญดังต่อไปนี ้
Resource Name > ชื่อของทรัพยากร 
Type > ประเภทของทรัพยากร 
Std. Rate > ค่าใช้จ่ายทรัพยากรต่อชั่วโมง 
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Ovt.Rate> ค่าใช้จ่ายต่อชั่วโมงในกรณีท างานนอกเวลา 
Cost/Use> ค่าใช้จ่ายที่ใช้ต่อครั้ง เช่น ค่าขนส่งเป็นต้น 
Accrue At> ช่วงเวลาที่จะต้องจ่ายค่าใช้จ่ายมี 3 แบบ คือ 

1. Start- จ่ายค่าใช้จ่ายทั้งหมดตั้งแต่เริ่มต้น หรือจ่ายเงินล่วงหน้าไปก่อน เช่นการสั่งซื้อ 
วัตถุดิบ  

2. Prorated-จ่ายค่าใช้จ่ายตามเปอร์เซ็นที่ท างานได ้หรืองานที่เกิดขึ้นจริง เช่นการจ่าย 
เงินเดือนพนักงานทุกเดือนตามที่พนักงานท างานจริง 

3. End-จ่ายค่าใช้จ่ายทั้งหมดเมื่องานเสร็จเรียบร้อยแล้วตามที่ได้ตกลงกันไว้ เช่นทันที
ที่งานเสร็จ “แก้ไข” แล้วจึงจะจ่ายเงินให้ ถ้างานไม่เสร็จก็ไม่จ่าย  

Base Calendar >ตารางการท างานของแต่ละทรัพยากร 
 

 
 

ในขั้นตอนการป้อนทรัพยากรให้แต่ละงาน วิธีการ คือ เลือกขั้นตอนที่ต้องการจะป้อนแล้วกดที่ 
Assign Resource ดังรูป 
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 เลือกทรัพยากรที่ต้องการจะใช้ในแต่ละขั้นตอน ดังรูป 
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 เมื่อป้อนทรัพยากรเสร็จแล้ว จะได้ดังรูป 
 

 
 

 โปรแกรม Microsoft office project สามารถผลิตรายงานเพื่อสรุปผลได้ โดยมีขั้นตอน คือ 
เลือกที่ Report > Reports ดังรูป 
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 จะมีรูปแบบของการผลิตรายงานให้เลือกหลายประเภท ในที่นี้จะผลิตรายงานเพื่อดูว่า
ค่าใช้จ่ายที่เกิดขึ้น เป็นจ านวนเท่าใด 
 

 
 

 จะได้รายงานตามความต้องการที่แสดงค่าใช้จ่ายขึ้นมา ดังรปู 
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 การออกแบบและการพิมพ์งาน 
 เลือกรายการ Report  Reports เลือกรายงานย่อย ตามปกติจะมีรูปแบบส าเร็จรูปให้เลือก

แค่ดับเบิ้ลคลิกหัวข้อของงานที่ต้องการ 

            
 

 การสั่งพิมพ์งาน  
    วิธีการสั่งพิมพ์งานและการตั้งค่าก่อนพิมพ์ ท าได้ดังนี้ 

1. เลือกค าสัง่ FilePrint  
2. เลือกเครื่องพิมพ์ระบุหน้าที่พิมพ์ในหัวข้อ Print Range  
3. ระบุหน้าที่ต้องการพิมพ ์
4. ใส่จ านวนชุดเอกสาร 
5. ดูตัวอย่างก่อนพิมพ ์
6. หากต้องการพิมพ์ออกทางเครื่องพิมพ์ให้กดปุ่ม OK 

 
 
 

 


